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iIntroduction
Welcome! This Step by Step book has been designed so you can read it from the 
beginning to learn about Microsoft Visio 2016 and then build your skills as you learn 
to perform increasingly specialized procedures. Or, if you prefer, you can jump in 
wherever you need ready guidance for performing tasks. The how-to steps are deliv-
ered crisply and concisely—just the facts. You’ll also find informative, full-color graphics 
that support the instructional content.

Who this book is for
Microsoft Visio 2016 Step by Step is designed for use as a learning and reference 
resource by home and business users of Microsoft Office programs who want to use 
Visio to create a variety of diagrams for business and personal use. The content of the 
book is designed to be useful for people who have previously used earlier versions of 
Visio and for people who are discovering Visio for the first time.

The Step by Step approach
The book’s coverage is divided into parts representing general Visio skill sets. Each 
part is divided into chapters representing skill set areas, and each chapter is divided 
into topics that group related skills. Each topic includes expository information fol-
lowed by generic procedures. At the end of the chapter, you’ll find a series of practice 
tasks you can complete on your own by using the skills taught in the chapter. You can 
use the practice files that are available from this book’s website to work through the 
practice tasks, or you can use your own files.
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Adapt procedure steps
This book contains many images of user interface elements (such as the ribbon and 
the app windows) that you’ll work with while performing tasks in Visio on a Windows 
computer. Depending on your screen resolution or app window width, the Visio 
ribbon on your screen might look different from that shown in this book. (If you turn 
on Touch mode, the ribbon displays significantly fewer commands than in Mouse 
mode.) As a result, procedural instructions that involve the ribbon might require a 
little adaptation.

Simple procedural instructions use this format:

1.	 On the Insert tab, in the Illustrations group, click the Pictures button.

If the command is in a list, our instructions use this format:

1.	 On the Home tab, in the Editing group, click the Layers arrow and then, in the 
Layers list, click Layer Properties.

If differences between your display settings and ours cause a button to appear differ-
ently on your screen than it does in this book, you can easily adapt the steps to locate 
the command. First click the specified tab, and then locate the specified group. If a 
group has been collapsed into a group list or under a group button, click the list or 
button to display the group’s commands. If you can’t immediately identify the button 
you want, point to likely candidates to display their names in ScreenTips.

Multistep procedural instructions use this format:

1.	 Display the Backstage view.

2.	 In the left pane of the Backstage view, click New.

3.	 On the New page, click Categories, click the Business thumbnail, and then 
double-click the Organization Chart template.
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On subsequent instances of instructions that require you to follow the same process, 
the instructions might be simplified in this format because the working location has 
already been established:

1.	  On the New page of the Backstage view, click Categories, click the Business 
thumbnail, and then double-click the Organization Chart template.

The instructions in this book assume that you’re interacting with on-screen elements 
on your computer by clicking (with a mouse, touchpad, or other hardware device). If 
you’re using a different method—for example, if your computer has a touchscreen 
interface and you’re tapping the screen (with your finger or a stylus)—substitute the 
applicable tapping action when you interact with a user interface element. 

Instructions in this book refer to Visio user interface elements that you click or tap on 
the screen as buttons, and to physical buttons that you press on a keyboard as keys, to 
conform to the standard terminology used in documentation for these products.

When the instructions tell you to enter information, you can do so by typing on an 
external keyboard, tapping an on-screen keyboard, or even speaking aloud, depend-
ing on your computer setup and your personal preferences.

Introduction
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Download the practice files
Before you can complete the practice tasks in this book, you need to download the 
book’s practice files to your computer from http://aka.ms/Visio2016sbs/downloads. 
Follow the instructions on the webpage.

IMPORTANT  Visio 2016 is not available from the book’s website. You should install that 
app before working through the procedures and practice tasks in this book.

You can open the files that are supplied for the practice tasks and save the finished 
versions of each file. If you later want to repeat practice tasks, you can download the 
original practice files again.

The following table lists the practice files for this book.

Chapter Folder File

1: Get started with Visio 2016 Visio2016SBS\Ch01 ExploreDrawing.vsdx

GetStarted.vsdx

ManageShapesWindow.vsdx

PanAndZoom.vsdx

2: Create diagrams Visio2016SBS\Ch02 PositionShapes.vsdx

ResizeShapes.vsdx

SelectShapes.vsdx

UseAutoAddAutoDelete.vsdx

UseAutoConnect.vsdx

UseDynamicConnectors.vsdx

UseLines.vsdx

3: Manage text, shapes, and 
pages

None None

4: Create business process 
diagrams

Visio2016SBS\Ch04 CreateSubprocesses.vsdx

5: Create organization charts Visio2016SBS\Ch05 AlterLayout.vsdx

OrgChartData.xlsx

Photos folder with 27 images of 
people
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Chapter Folder File

6: Add style, color, and themes Visio2016SBS\Ch06 AlignSpaceShapes.vsdx

7: Create network and 
datacenter diagrams

Visio2016SBS\Ch07 ChangeDrawingScale.vsdx

CreateRacks.vsdx

8: Work with shape data Visio2016SBS\Ch08 CreateModifyReports.vsdx

EditShapeData.vsdx

InsertFields.vsdx

ModifyDataAttributes.vsdx

RunReports.vsdx

Vegetation Report.vrd

9: Visualize your data Visio2016SBS\Ch09 CreateDataGraphics.vsdx

RiskManagementTaskMap.pdf

10: Link to external data Visio2016SBS\Ch10 Photos\Oleg Anashkin.jpg

OrgChartData.xlsx

OrgChartData_Supplement1.xlsx

UseQuickImport.vsdx

UseCustomImport.vsdx

11: Add and use hyperlinks Visio2016SBS\Ch11 EnhanceDiagrams.vsdx

FollowHyperlinks.vsdx

Human Resources Policy 
Manual.docx

12: Print, reuse, and share 
diagrams

Visio2016SBS\Ch12 CreateGraphics.vsdx

CreateTemplates.vsdx

PreviewDrawings.vsdx

PublishToWeb.vsdx

SaveInFormats.vsdx

13: Add structure to your 
diagrams

Visio2016SBS\Ch13 AnnotateShapes.vsdx

OrganizeByContainers.vsdx

OrganizeByLists.vsdx

xvii
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Chapter Folder File

14: Validate diagrams Visio2016SBS\Ch14 ReuseRules.vsd

RuleSets--BPMN 2.0.html

RuleSets--Cross-Functional 
Flowchart.html

RuleSets--Flowchart.html

RuleSets--SharePoint 2010 
Workflow.html

RuleSets--SharePoint 2016 
Workflow.html

ValidateBPMN.vsdx

ValidateFlowcharts.vsdx

ValidateSwimlanes.vsdx

15: Collaborate and publish 
diagrams

None None

Appendix A: Look behind the 
curtain

Visio2016SBS\AppA ViewShapeSheet.vsdx

Appendix B: Keyboard 
shortcuts for Visio

None None

Ebook edition
If you're reading the ebook edition of this book, you can do the following:

■■ Search the full text

■■ Print

■■ Copy and paste

You can purchase and download the ebook edition from the Microsoft Press Store at 
http://aka.ms/Visio2016sbs/details.
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Get support and give feedback
This topic provides information about getting help with this book and contacting us 
to provide feedback or report errors.

Errata and support
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. If you discover an error, please submit it to us at http://aka.ms/Visio2016sbs 
/errata.

If you need to contact the Microsoft Press Support team, please send an email message 
to mspinput@microsoft.com.

For help with Microsoft software and hardware, go to http://support.microsoft.com.

We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
valuable asset. Please tell us what you think of this book at http://aka.ms/tellpress.

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at http://twitter.com 
/MicrosoftPress.

xix
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9Visualize your 
data

In this chapter
■■ Enhance diagram effectiveness

■■ Create data graphics

■■ Apply data graphics

■■ Edit data graphics

■■ Create data graphic legends

Practice files
For this chapter, use the practice 
files from the Visio2016SBS\Ch09 
folder. For practice file download 
instructions, see the introduction.

In Chapter 8, “Work with shape data,” you viewed and 
reported on data stored in Visio shapes. Although those 
techniques are useful in many circumstances, Visio pro-
vides an even more effective way to take advantage of 
data: you can create data graphics that enhance shapes 
by adding text callouts and icons based on the data 
contained in the shapes. Even better, data graphics are 
dynamic, so when the data in a shape changes, Visio 
refreshes the graphics automatically.

In the next chapter, you will take data graphics to another 
level by visualizing data stored in an external location. 
In this chapter, you will work with data graphics by using 
data that is stored in the diagram and discover the amaz-
ing ways you can visualize data by using Visio 2016.

IMPORTANT  The information in this chapter applies 
only to the Professional edition of Visio 2016. 

This chapter guides you through procedures related to 
enhancing diagram effectiveness, creating and applying 
data graphics, editing data graphics, and creating data 
graphic legends.
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Enhance diagram effectiveness
A person using a Visio diagram that you created can learn a lot about the subject of 
the diagram based on your choice of shapes, their positions on the page, the way they 
are connected, and many additional visual cues. The five sections in this topic demon-
strate the power of data visualization to tell even more of the story.

View network and datacenter performance
Chapter 7, “Create network and datacenter diagrams” contains several hints about the 
data available in computer, network, and rack diagram shapes. This section explores tech-
niques you can use to capitalize on the data that is included in the Visio network shapes.

The diagrams in this section might be used in a scenario such as the following:

■■ You are a datacenter manager and have created rack diagrams for each rack in 
your computer room.

■■ You’ve populated your diagrams with data.

■■ Each rack-mounted server includes the data fields shown in Figure 9-1. (The 
values shown in this figure will be visualized in the next two figures.)

Figure 9-1  Sample server data

You can visualize data like that shown in Figure 9-1 by using Visio data graphics to 
turn an ordinary rack diagram into a powerful means to understand server attributes. 

Chapter 9: Visualize your data
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In Figure 9-2, several data graphics are applied to the servers in an equipment rack to 
highlight the following:

■■ Server name and type (left)

■■ Server status (center)

■■ CPU and memory configuration (right)

Figure 9-2  A rack diagram showing server status and vital statistics

Figure 9-3 shows the same equipment rack, but it uses different data graphics to high-
light different information. In this version of the rack diagram, you find the following:

■■ Server name and IP address (left)

■■ Server status (center) shown by applying a fill color to the servers instead of 
attaching a status icon.

■■ Operating system name (right)

Figure 9-3  Alternate visualizations provide different information

Enhance diagram effectiveness
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Part of the appeal of data graphics is represented by these two examples—you can 
apply different graphics at different times depending on what you need to know.

Improve processes
In this example, data graphics are applied to process steps in a swimlane diagram for 
two reasons: to number each process step (the number appears above the upper-
right corner of each shape), and to show several process quality measurements. The 
information in Figure 9-4 includes the following:

■■ The average duration of each step, in days, is shown in a progress bar across the 
bottom of each task shape.

■■ A warning icon appears in the lower-left corner of a shape if a step is taking 5 to 
9 days or 10 or more days.

■■ The shape color indicates whether a step is improving or being investigated.

The symbolism used for each of these metrics is explained in the data graphic legend 
that appears in the upper-right corner of the page. You will learn more about legends 
in “Create data graphic legends” later in this chapter.

Figure 9-4  A process diagram that displays data-driven graphics
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Manage casino operations
Figure 9-5 illustrates the types of near-real-time information that a casino manager 
might view in Visio, with a goal of monitoring critical operations. In all likelihood, 
your job doesn’t involve managing a casino, but you can probably think of important 
operations that you do need to monitor.

Figure 9-5  A casino manager’s view of a blackjack table

In the graphic, text callouts highlight each bettor’s recent history, including current 
dollar standing, average bet, and number of blackjacks. In addition, a red or green 
arrow represents how each player is trending.

TIP  The real-time nature of the graphics in this example are significantly enhanced 
when the diagram is linked to a live, external data source. You will explore this topic in 

Chapter 10, “Link to external data.” 

Manage employee performance
The organization chart in Figure 9-6 looks like those you explored in Chapter 5, 
“Create organization charts,” with one notable exception: Trey Research has turned 
this org chart into more than just a picture of who reports to whom by including two 
key performance measures:

■■ Each employee’s progress toward their annual training goal is depicted by an 
icon containing a combination of blue and gray squares.

■■ The three red manager shapes include a bar graph displaying quarterly perfor-
mance numbers. Note that the bar graph is a single graphic item that contrasts 
data from four different shape data fields.

Enhance diagram effectiveness
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The legend in the upper-right corner of the page is automatically generated by Visio; 
however, you can customize the text and other aspects of the legend. In this example, 
the descriptions were customized and the font color was changed.

Figure 9-6  An org chart enhanced with employee performance data

TIP  You can apply only one data graphic to a shape at any given moment. However, as 
Figure 9-6 shows, one data graphic can contain multiple visual elements. In addition, 

you can apply different graphics to different shapes on the same page.

Assess risks
In the example shown in Figure 9-7, you are viewing part of a process map that was 
created by using a Visio add-in called TaskMap (www.taskmap.com). 

Chapter 9: Visualize your data
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This portion of the TaskMap shows three tasks in the middle of a sales proposal pro-
cess, and data graphics depict the following two aspects of risk management:

■■ Yellow triangles and green diamonds identify risks and controls, respectively. 
The number in each risk triangle relates to an entry in a master list of risks. The 
number in each diamond identifies the control that the organization has put 
in place to mitigate the risk. (An organization might maintain the master list of 
risks and controls in something as simple as a worksheet, or they might employ 
a formal risk management system.)

In a task like the one in the center, the organization has identified a risk but not 
a control, so the risk is more significant.

■■ The red arrows highlight tasks that exceed a defined time threshold—30 minutes 
in the case of this example.

Figure 9-7 also includes a third data graphic: two of the three tasks display a red dia-
mond to indicate that they are decision points in the process.

Figure 9-7  A TaskMap process map used to convey risk and time threshold data

TIP  If you would like to look at the full page from which Figure 9-7 was taken, 
open the RiskManagementTaskMap PDF in the Visio2016SBS\Ch09 folder. In 

addition, a web-published version of this TaskMap that includes hyperlinks to Microsoft  
Word and Excel documents is available at www.visiostepbystep.com/downloads/2016 
/RiskManagementTaskMap.htm.

The examples in this section highlight the importance of the data behind a diagram and 
suggest a variety of creative ways you can add value to diagrams that contain data.

Enhance diagram effectiveness

307



Create data graphics
In Chapter 10, “Link to external data,” you will discover a simple technique for apply-
ing data graphics to shapes that are linked to data in an external file or database. 
However, linking to external data is not a requirement for using data graphics. Even 
if you’ve manually entered data into your shapes, you can still represent that data 
visually.

Each data graphic you create can contain one or more graphic items. Each graphic 
item is associated with a data field and presents data by using one of the following 
formats:

■■ Callout  A formatted text box, sometimes accompanied by an icon, that is used 
to display text

TIP  In some places in the Visio user interface, the name of this category is shown 
as Text Callout or just Text. 

■■ Icon Set  A collection of up to five icons that are used to represent specific 
values or ranges of values

■■ Data Bar  One of a set of progress bars, star ratings, pie charts, graphs, or other 
graphics used to represent numeric values

■■ Color by Value  A technique for setting the color of a shape based on the value 
of a data field in the shape

You create and apply data graphics by using options on the Data tab. Portions of the 
Data tab—the Data Graphics gallery and several buttons—will be dimmed (unavail-
able) if you have not linked your diagram to external data; these portions are omitted 
from the images of the Data tab shown in Figure 9-8. However, the Advanced Data 
Graphics button on the right end of the tab is always available, and that’s the button 
you use to create data graphics in an unlinked diagram.

Figure 9-8  The Visio Professional Data tab

Chapter 9: Visualize your data

308



9

Clicking the Advanced Data Graphics button opens the Data Graphics gallery, which 
includes a Create New Data Graphic button. The first step in creating a data graphic is 
to create a graphic item, and the first step in doing that is to select a data field. 

The list of available data fields varies depending on which shapes are selected when 
you click the Create New Data Graphic button. If no shapes are selected, or if the 
selected shapes have one or more data fields in common, a list like the one shown in 
the upper half of Figure 9-9 is displayed. If a set of shapes with no common fields is 
selected, an abbreviated list such as the one shown in the lower half of Figure 9-9 is 
displayed.

In either case, you can use the More Fields entry shown in both parts of Figure 9-9 to 
create more sophisticated data graphics. For example, instead of creating a graphic 
based on a shape data field, you can create a graphic based on a document or page 
property, or based on a calculated result.

Figure 9-9  New data graphics can be based on shape data fields or data that resides elsewhere in a 
diagram

After selecting a data field, your next choice is which of the four graphic item types 
you want to use. The first three graphic types provide a list of choices, as shown from 
left to right in Figure 9-10 for the Text, Data Bar, and Icon Set lists.

Create data graphics

309



Figure 9-10  Data graphics offer an impressive range of colorful choices for representing data

Choosing an icon set requires you to specify which value, or range of values, applies 
to each icon. Figure 9-11 shows the settings for a data graphic you will apply in the fol-
lowing topic. Although this figure designates a specific value for each icon, you have 
considerable flexibility in defining the conditions for each flag. You can:

■■ Use the list in the center column to create a range of values for each icon and to 
set other conditions.

■■ Use the list on the right to enter more sophisticated values than simply typing a 
number or text into the field.

The fourth data graphic type, Color By Value, extracts data values from the selected 
field and matches each with a color, as shown in Figure 9-12.

TIP  The colors selected by Visio in Figure 9-12 are suitable for some purposes but might 
be too bold for other purposes. In the latter case, you can display the Fill Color list for 

any field and change the color setting. You can also leave the text color of affected shapes at 
the default setting (as shown in the figure) or you can manually change it.

IMPORTANT  Notice the Insert and Delete buttons to the right of the Color Assign-
ments section in Figure 9-12. You can delete any combination of value and color, or you 

can add new ones, depending on what you want to highlight in the drawing. For example, if 
you don’t want to apply a fill color when the selected field has a blank value, delete the row in 
which the value box is blank.

Chapter 9: Visualize your data
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9Figure 9-11  The options for configuring icon set graphics are flexible 

Figure 9-12  Visio identifies existing data values and selects colors when you create a color-by-value data 
graphic

Create data graphics
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To select a field to create a data graphic

1.	 Open the New Data Graphic dialog box by doing either of the following:

●● On the Data tab, in the Advanced Data Linking group, click Advanced Data 
Graphics, and then click Create New Data Graphic.

●● Right-click any shape that does not contain a data graphic, click Data, and 
then click Edit Data Graphic.

2.	 Click the New Item button.

3.	 In the New Item dialog box, click the Data field arrow, and then click the name 
of the field you want to visualize.

IMPORTANT  You can add more than one graphic item to any data graphic as you 
create it. To do so in each of the next four procedures, click the New Item button again 

before clicking OK to close the New Data Graphic dialog box. 

To create a Text data graphic

1.	 Select a field to visualize, click the Displayed as arrow, and then click Text.

2.	 Click the Style arrow, and then click the name of the text callout you want.

3.	 (Optional) Change configuration values in the Details section.

4.	 (Optional) Either select the Use default position check box, or use the Horizontal 
and Vertical lists to select a specific position for your data graphic.

5.	 Click OK to close the New Item dialog box, and then click OK to close the New 
Data Graphic dialog box.

To create a Data Bar data graphic

1.	 Select a field to visualize, click the Displayed as arrow, and then click Data Bar.

2.	 Click the Style arrow, and then click the name of the data bar you want.

3.	 (Optional) Change Minimum Value, Maximum Value, or other configuration 
values in the Details section.

4.	 (Optional) Either select the Use default position check box, or select an option 
from the Horizontal and Vertical lists to select a specific position.

5.	 Click OK to close the New Item dialog box, and then click OK to close the New 
Data Graphic dialog box.

Chapter 9: Visualize your data
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To create an Icon Set data graphic

1.	 Select a field to visualize, click the Displayed as arrow, and then click Icon Set.

2.	 Click the Style arrow, and then click the icon set you want.

3.	 Click the appropriate condition from the list in the center column of the Rules 
for showing each icon section, and then enter values in the right column in the 
same section.

4.	 (Optional) Either select the Use default position check box, or select an option 
from the Horizontal and Vertical lists to select a specific position.

5.	 Click OK to close the New Item dialog box, and then click OK to close the New 
Data Graphic dialog box.

To create a Color By Value data graphic

1.	 Select a field to visualize, click the Displayed as arrow, and then click Color by 
Value.

2.	 (Optional) Click the Coloring Method arrow, and then click either Each color 
represents a unique value or Each color represents a range of values.

3.	 Either leave the entries in the Value, Fill Color, and Text Color fields in the Color 
assignments section as is, or make the changes you want.

4.	 Click OK to close the New Item dialog box, and then click OK to close the New 
Data Graphic dialog box.

Apply data graphics
You must select one or more shapes before opening the Data Graphics gallery 
because you can apply or remove data graphics only on preselected shapes. After 
selecting shapes, you can point to the options in the Available Data Graphics section 
of the gallery, shown in Figure 9-13, to provide a live preview so you can sample vari-
ous graphics before choosing one.

Apply data graphics
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Figure 9-13  Thumbnails of three data graphics appear in a data graphics gallery

The examples shown in the next two figures use shape data fields called Risk and 
Owner. The Risk field was added to the shapes in this diagram, whereas Owner is a 
predefined field in all Visio flowchart shapes.

Figure 9-14 shows the result of assigning two different data graphics to the same set 
of process steps. The upper section of the figure uses an icon set to represent the level 
of risk associated with each step. The lower section employs a color-by-value graphic 
that is based on the Owner data field, essentially creating a map that is color-coded to 
show who does what within the process.

Figure 9-14  The same set of flowchart shapes can impart dramatically different information by using different 
data graphics
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TIP  Visio data graphics are automatically assigned to a special layer in a diagram. (See 
“Understand and use layers” in Chapter 3, “Manage text, shapes, and pages.”) If you 

want to hide data graphics without removing them, you can change the view properties for the 
data graphics layer.

You can assign only one data graphic at a time to any given shape. However, you can 
include multiple graphic items within one data graphic. The diagram in Figure 9-15 
features a single data graphic that includes both of the graphic items that are shown 
separately in Figure 9-14.

Figure 9-15  You can create data graphics that have multiple graphic items

TIP  Data graphics are applied to a single page at a time. If you want to apply the same 
data graphic to multiple pages, you must either apply it to each page separately, or 

write a Visio macro to do that for you. 

�If you want to apply the same data graphic automatically to a shape regardless of the page on 
which the shape resides, you can apply the data graphic to the shape and save the shape as a 
master in a custom stencil. Then, whenever you drag the master onto the drawing page, it will 
automatically display the data graphic. You will learn about macros and creating custom sten-
cils in Appendix A, “Look behind the curtain.”

To apply a data graphic to one or more selected shapes

1.	 On the Data tab, in the Advanced Data Linking group, click the Advanced 
Data Graphics button to display a gallery of data graphic options and 
thumbnails.

2.	 In the Advanced Data Graphics gallery, click the thumbnail for the data graphic 
you want to apply.

To remove a data graphic from one or more selected shapes

1.	 Display the Advanced Data Graphics gallery, and then click the None thumb-
nail in the No Data Graphic section.

Apply data graphics
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TIP  In Chapter 10, “Link to external data,” you will discover additional techniques for 
applying data graphics in diagrams that have been linked to external data sources.

Edit data graphics
The placement and appearance of data graphics are controlled by an editable set 
of parameters. Although you can’t control every attribute of a data graphic without 
resorting to writing code, the Visio 2016 user interface provides tools to implement 
a surprising number of changes by using the Edit Data Graphic dialog box, shown in 
Figure 9-16.

Figure 9-16  Data graphics can contain multiple graphic items of different types

The upper half of the Edit Data Graphic dialog box lists all of the graphic items that 
are part of the selected data graphic. You can add, edit, or delete each graphic item. 
In the lower half of the dialog box, you can modify the characteristics of the data 
graphic as a whole.

IMPORTANT  You establish the default position for a data graphic by selecting from 
the Horizontal and Vertical lists in the Default Position of the Edit Data Graphic dialog 

box. (Both the horizontal and vertical positions are relative to the shape to which the graphic 
will be attached.) Data graphic items in the upper half of the dialog box whose Position is set to 
Default will appear at this location.
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You use the Edit Item dialog box to change display properties. The specific properties 
in the dialog box vary based on the selected graphic item.

For the Thermometer graphic shown in Figure 9-17, you can specify the minimum and 
maximum values so Visio can properly scale the height of the red inside the ther-
mometer. You can also adjust labels and other icon attributes.

IMPORTANT  The Minimum Value and Maximum Value fields are critical for all Data 
Bar graphic items, not just the Thermometer icon. If these values are set incorrectly, the 

height or width, depending on the graphic item, will be incorrect.

Figure 9-17  You can accept default values in many situations but can customize data graphics as needed

In the upper-right corner of the dialog box, you can select the check box to position a 
graphic item at the default position for the data graphic that contains it. You can also 
clear that check box and select from the options in the Horizontal and Vertical lists to 
set your own location relative to the underlying shape.

Edit data graphics
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To edit a data graphic

1.	 Display the Advanced Data Graphics gallery, right-click the thumbnail of the 
data graphic you want to change, and then click Edit.

Or

Right-click any shape that contains the data graphic you want to change, click 
Data, and then click Edit Data Graphic.

2.	 In the Edit Data Graphic dialog box, click the graphic item you want to edit, 
and then click the Edit Item button.

Or

Double-click the graphic item you want to edit.

3.	 Make your changes in the Edit Item dialog box, and then click OK.

4.	 (Optional) Change the settings in the Default position, Display options, or 
Apply changes to sections of the Edit Data Graphic dialog box.

TIP  The next step is useful if you are still experimenting with how you want the 
data graphic to look on the page.

5.	 (Optional) Click the Apply button to see the changes in the diagram without 
closing the Edit Data Graphic dialog box.

6.	 Click OK.

To rename a data graphic

1.	 Display the Advanced Data Graphics gallery, right-click the thumbnail of the 
data graphic you want to rename, and then click Rename.

2.	 Enter a new name, and then click OK.

To duplicate a data graphic

1.	 Display the Advanced Data Graphics gallery, right-click the thumbnail of the 
data graphic you want to duplicate, and then click Duplicate.

To select all shapes that use a particular data graphic

1.	 Display the Advanced Data Graphics gallery, right-click the thumbnail of a data 
graphic, and then click Select Shapes that use this Graphic.
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To delete a data graphic

1.	 Display the Advanced Data Graphics gallery, right-click the thumbnail of the 
data graphic you want to delete, and then click Delete.

TIP  In Chapter 10, “Link to external data,” you will discover additional techniques for 
editing data graphics in diagrams that have been linked to external data sources. 

Create data graphic legends
Data graphics like the one shown in Figure 9-15 earlier in this chapter are easier to 
use and understand with a key. With Visio 2016, a data graphic legend is just a click 
away. You can create either a vertical legend, or, as shown in Figure 9-18, a horizontal 
legend.

TIP  Visio always places the legend in the upper-right corner of the page. 

Figure 9-18  Visio creates legends automatically, but you can customize them

After Visio creates the legend, you can edit the elements within the legend. For exam-
ple, the legend on the left in Figure 9-18 is the original version. In the legend on the 
right, the descriptions for the flag icons have been changed to be more meaningful for 
users of the diagram.

IMPORTANT  After placing a data graphic legend on the page, Visio never updates it. 
Consequently, if you add or delete a data graphic or change the attributes of a graphic 

in a way that affects the legend, you must delete the existing legend and insert a new one.

Create data graphic legends
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TIP  Visio constructs data graphic legends from a combination of containers and lists. 
For details about containers and lists, see Chapter 13, “Add structure to your diagrams.” 

To insert a data graphic legend

1.	 On the Data tab, in the Display Data group, click the Insert Legend button.

2.	 Click either Horizontal or Vertical.

To edit a data graphic legend

1.	 Click an entry inside the legend and enter new text.

2.	 Click an entry inside the legend and drag it to a new location.

To move a data graphic legend

1.	 Click the word Legend in the header of the data graphic legend, and then drag 
the legend to a new location.

To delete a data graphic legend

1.	 Do any of the following:

●● Click the word Legend in the header of the data graphic legend, and then 
press the Delete key.

●● Right-click the word Legend, and then click Cut on the shortcut menu.

●● Right-click the word Legend, and then on the Home tab, in the Clipboard 
group, click Cut.

Skills review
In this chapter, you learned how to:

■■ Enhance diagram effectiveness

■■ Create data graphics

■■ Apply data graphics

■■ Edit data graphics

■■ Create data graphic legends

Chapter 9: Visualize your data
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Practice tasks
The practice files for these tasks are located in the Visio2016SBS\Ch09 
folder. You can save the results of the tasks in the same folder.

Enhance diagram effectiveness
There are no practice tasks for this topic.

Create data graphics
Open the CreateDataGraphics diagram in Visio, and then perform the following tasks:

1.	 Create a Text data graphic with the following characteristics:

Data field:	 Owner

Style:	 Heading 1

Horizontal:	 Center

Vertical:	 Top Edge

Horizontal Offset	 None

2.	 Create a Data Bar graphic for the Cost field with the following characteristics:

Located at the default position

Style:	 Thermometer

Maximum Value	 150

3.	 Create an Icon Set data graphic for the Status field and apply the settings 
shown in Figure 9-11.

4.	 Create a Color by Value data graphic for the Owner field, ensuring that there is 
not a color assigned to a blank value.

5.	 Save the diagram as DataGraphicsFlowchart for use in the next tasks.

Apply data graphics
Open the DataGraphicsFlowchart diagram in Visio, and then perform the following 
tasks:

1.	 Apply the Text data graphic to all process steps except Start and End.

2.	 Apply the Data Bar data graphic to all process steps except Start and End. 
Change the Cost value in several shapes and observe the results.

321

Practice tasks



3.	 Apply the Icon Set data graphic to all process steps except Start and End. 
Change the Status value in several shapes and observe the results.

4.	 Apply the Color by Value data graphic to all process steps except Start and 
End. Change the Owner value in several shapes and observe the results.

5.	 Save your changes, and leave the diagram open if you’ll be continuing to the 
next tasks.

Edit data graphics
Open the DataGraphicsFlowchart diagram in Visio, and then perform the following 
tasks:

1.	 Apply the Data Bar (Thermometer) data graphic to the process shapes in the 
top row, and then edit the data graphic by changing the Vertical position to 
Top Edge, and Value Position and Label Position to Not Shown.

2.	 Apply the Icon Set data graphic to any three-process steps, and then edit the 
data graphic by selecting a different set of icons.

3.	 Assign the Color by Value data graphic to the process steps in the lower row, 
and then edit the data graphic by assigning different fill colors and text colors 
to one or more data values.

4.	 Assign a more meaningful name to the data bar data graphic.

5.	 Create a duplicate copy of the Icon Set data graphic, and then change the visu-
alization type to Color by Value.

6.	 Assign the duplicated data graphic to some of the process steps.

7.	 Select all shapes that currently use the Data Bar graphic and assign the dupli-
cated data graphic to them.

8.	 Delete the duplicated data graphic.

9.	 Save your changes, and leave the diagram open if you’ll be continuing to the 
next tasks.
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Create data graphic legends
Open the DataGraphicsFlowchart diagram in Visio, and then perform the following 
tasks:

1.	 Apply the Icon Set data graphic to all process steps in the upper row.

2.	 Apply the Data Bar data graphic to all process steps in the lower row.

3.	 Add a Vertical legend to the page.

4.	 Move the legend to a new location.

5.	 Delete the legend, and then insert a Horizontal legend.

6.	 Change the text of one or more explanations in the Status column of the 
legend.
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13Add structure 
to your 
diagrams

In this chapter
■■ Understand containers, lists, 

and callouts

■■ Compare groups and containers

■■ Organize shapes by using 
containers

■■ Organize shapes by using lists

■■ Find containers and lists in Visio

■■ Annotate shapes by using 
callouts

Practice files
For this chapter, use the practice 
files from the Visio2016SBS\Ch13 
folder. For practice file download 
instructions, see the introduction.

In many types of Visio diagrams, it’s useful to create 
visual or logical relationships among a set of shapes. The 
traditional technique for doing this in Visio has been to 
use background shapes and groups. However, Visio 2016 
offers three special shape types—containers, lists, and 
callouts—that can be even more effective when you 
want to establish relationships and add structure to your 
diagrams.

Structured diagram shapes are so useful that Visio itself 
relies on them for a growing number of templates and 
special uses. For example, you will find lists and contain-
ers in swimlane diagrams, wireframes, and data graphic 
legends; and you will encounter callouts in the Business 
Process Model and Notation (BPMN) template (Visio 
Professional only).

This chapter guides you through procedures related to 
organizing shapes by using containers or lists, finding 
containers and lists in Visio, and annotating shapes by 
using callouts.
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Understand containers, lists, and callouts
Visio 2010 introduced three structured diagram shape types:

■■ Containers  A container provides a visual boundary around a set of objects, but 
it also establishes a logical relationship between the container and the objects 
within it—shapes know when they are members of a container and containers 
know which shapes they contain.

The key advantage of a container is that while you can move, copy, or delete it 
and its members as a unit, each contained shape maintains its independence. 
Unlike grouped shapes, selecting an object inside a container only requires one 
click, which makes it simple to access the shape data and other properties of a 
container member.

TIP  A container can contain shapes, other containers, and lists.  

■■ Lists  A list is a special type of container that maintains an ordered relationship 
among its members. Each object in a list knows its ordinal position, and new 
objects are not merely added to a list but are added to a specific position in a list.

TIP  A list can contain shapes and containers but cannot contain other lists. 

■■ Callouts  In previous versions of Visio, a callout was merely a shape that you 
glued to another shape to add a comment. A Visio 2016–style callout still pro-
vides a way to add annotation to a shape, but the callout knows the shape to 
which it is attached, and the shape can identify any attached callouts.

What is the value to you if shapes know where they live and containers and lists know 
what they contain? Think about a shape that automatically knows whether it’s first, 
second, or third in a list and displays that data (explained in the section “Add shapes 
to lists” in the “Organize shapes by using lists” topic later in this chapter). Or think 
about the potential uses for a shape that displays data from its parent container—and 
the data changes automatically if you move the shape to a different container (covered 
in the “Explore swimlanes” section in the “Find containers and lists in Visio” topic later in 
this chapter).
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Although it’s true that containers, lists, and callouts are just Visio shapes, each 
includes unique properties and formulas that give it special capabilities.

Compare groups and containers
You can use either groups or containers to visually connect a set of shapes. However, 
the two have key behavioral differences that are likely to lead you in one direction or 
the other. The diagrams in this topic contain two sets of shapes that will serve to illus-
trate the similarities and differences. The green shapes on the left in the diagrams are 
part of a group; the gold shapes on the right are located inside a container.

In the image on the left in Figure 13-1, the arrows and square are grouped with a gold 
rectangle by using the traditional Visio technique:

1.	 Draw a rectangle (or other shape).

2.	 Send the new shape to the back of the Z-order.

3.	 Select the rectangle and the shapes you want in the group.

4.	 Group the selected shapes.

TIP  For information about creating and using groups, see Chapter 3, “Manage 
text, shapes, and pages.” The same chapter also describes moving shapes 

backward and forward in the Z-order of a page.

Prior to the introduction of containers in Visio 2010, this was the only technique for 
creating a visual association among a set of shapes.

In contrast, the shapes on the right in Figure 13-1 were placed into a container. One 
difference is immediately apparent: containers are not just plain rectangles; they 
include both a main section and a heading.

Figure 13-1  Shapes are grouped or contained

Compare groups and containers
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Three additional differences that are not easily captured in a screenshot become 
obvious when you work with groups and containers in Visio:

■■ If you click a shape that is located in a group, you select the group and not the 
shape. However, if you click a shape in a container, the first click selects the 
shape. In essence, a group stands between you and its shapes, but a container is 
invisible as you select shapes.

TIP  If you run Visio in developer mode, you can alter the selection characteris-
tics of a group. For more information about developer mode, see Appendix A, 

“Look behind the curtain.”

■■ To select a container and not a member of the container, you must click the 
heading or an edge of the container.

■■ As a result of the click behavior described in the preceding bullets, using a 
bounding box to select interior shapes in a container is easy—just click inside or 
outside the container, and then drag. However, to select shapes in a group by 
using a bounding box, you must start the bounding box outside of the group or 
you will inadvertently drag the group.

Groups and containers share several behaviors. For example, if you move either one, 
you move all shapes. If you delete either one, you delete everything. Similarly, you can 
copy and paste either as a unit.

One difference arises when you want to label the collection, however. When you click 
a group and start entering text, the text appears in the center of the group shape by 
default. Sometimes this placement is fine, but other times it’s not. The usefulness of the 
text in a group also depends on the color and style defaults of the theme you’re using.

In the group shown on the left in Figure 13-2, for example, the text is illegible because 
its default color is too similar to the color of the background shape. You can, of course, 
use the Text Block tool you worked with in Chapter 3, “Manage text, shapes, and 
pages,” to move the text, or you can change its color, but that requires extra steps.

Chapter 13: Add structure to your diagrams
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Clicking a container and entering text, on the other hand, automatically places the 
text in the heading, as shown on the right in Figure 13-2.

Figure 13-2  Text in a group can be obscured by the default font color or by the shapes in the group

If you drag a shape out of a group, is it still part of the group? What if you drag a 
shape out of a container?

The upper half of Figure 13-3 shows a double-headed arrow that has been dragged 
out of the group on the left and another that has been removed from the container 
on the right. In the lower half of the figure, the group and container have been moved 
to the right.

Notice the following:

■■ The green arrow moved with the group.

■■ The gold arrow remained in a fixed location.

From these observations, you can conclude the following:

■■ Dragging a shape from a group does not remove it from the group.

■■ Dragging a shape from a container removes it from the container.

Compare groups and containers
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Figure 13-3  The effects of dragging a shape out of a group and a container

Attempting to add shapes exposes a similar difference. In the upper half of Figure 13-4, 
a circle has been placed on top of the group on the left and the container on the right. 
In the lower half of the figure, the group and the container have been moved to the 
right.

Here are the conclusions you can draw from this:

■■ Placing a shape on top of a group does not add it to the group.

TIP  If you run Visio in developer mode, you can change the behavior of a group 
so it will accept dropped shapes. For more information about developer mode, 

see Appendix A, “Look behind the curtain.”

■■ Placing a shape on top of a container adds it to the container.
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Figure 13-4  The effects of placing a shape on top of a group and a container

The primary lesson from Figure 13-3 and Figure 13-4 is that unlike groups, Visio con-
tainers behave like physical containers: if you put an object in, it becomes part of the 
container; if you remove an object, it is no longer associated with the container.

Figure 13-5 illustrates a final behavior difference: resizing groups and containers pro-
duces strikingly different results. In the figure, both the group and the container were 
stretched by dragging the bottom resize handle downward.

Figure 13-5  Resizing a group resizes all subshapes; resizing a container does not affect member shapes

Compare groups and containers
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TIP  If you run Visio in developer mode, you can change the behavior of a group so the 
interior shapes do not resize. For more information about developer mode, see 

Appendix A, “Look behind the curtain.”

The following table summarizes the key differences between groups and containers.

Action Groups Containers

Resize Contents are resized with the 
group

Contents are not changed

Select an interior shape Requires two clicks (unless 
default group behavior has 
been changed)

Requires one click

Select interior shape(s) by 
using a bounding box

Cannot start a bounding box 
by clicking inside a group

Can start a bounding box by 
clicking anywhere

Drop a new shape inside Dropped shapes are not 
added to the group (unless 
default group behavior has 
been changed)

Dropped shapes are added to 
the container

Drag a shape out Shape is physically outside the 
group but remains part of the 
group

Shape is removed from the 
container

Enter text Text is placed in the center of 
the group

Text is placed in the 
container’s heading

TIP  Containers, lists, and callouts were introduced in Visio 2010 and were described by the 
Visio development team in a series of blog posts that are summarized at blogs.msdn.com 

/b/visio/archive/2010/09/02/new-structured-diagrams-whitepaper-for-visio-2010.aspx.

�Visio 2013 included additional containers and callouts and upgraded the style and appearance of 
both, as described in a blog post at blogs.office.com/2012/11/05/containers-and-callouts-in-visio/.

�For the technically inclined, the following article provides details about the inner workings 
of containers, lists, and callouts and is still relevant for Visio 2016 structured diagrams:  
msdn.microsoft.com/en-us/library/ff959245.aspx.
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Organize shapes by using containers
Grouped shapes are still valuable for many purposes, including holding collections 
of subshapes that are unlikely to change. However, Visio containers offer numerous 
advantages, especially for dynamically grouping, moving, and managing a set of 
related shapes.

One regular ribbon tab and one tool tab are vital for working with containers. The 
Insert tab, shown in Figure 13-6, is home to the Container gallery, which you use to 
add containers to a page.

Figure 13-6  The Container gallery offers 14 container styles

You use various functions on the Format tool tab in the Container Tools tab group, 
shown in Figure 13-7, to manage containers in ways you will explore in the sections of 
this topic.

Figure 13-7  The Format tool tab appears only when you select a container

Organize shapes by using containers
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Use containers
You can create an empty container and add shapes to it later, or you can create a 
container around existing shapes. In either case, your containers can appear in a 
variety of styles. Figure 13-8 shows the same set of network shapes in five different 
containers to illustrate the range of choices.

Figure 13-8  Examples of diverse container styles from simple to highly stylized

Containers provide visual feedback while you interact with them. As shown on the left 
in Figure 13-9, dragging a shape into a container causes the border of the container 
to “light up” in green. This type of feedback is a way to distinguish a container from a 
group or an ordinary shape.

The container border also lights up when you select any contained shape, as shown 
on the right in Figure 13-9. This behavior is evidence of the relationship between 
containers and members that was described in “Understand containers, lists, and 
callouts” earlier in this chapter.

Figure 13-9  Adding or selecting shapes highlights the surrounding container

Because containers were designed to remain connected to their members, it’s easy to 
copy or delete both as a unit by selecting the container. The only trick when selecting 
the container is to remember that the body of a container is invisible to mouse clicks. 
You must click the header or one of the edges to select it.
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If you want to copy or delete just the members but not the container, that’s also easy 
because there are several techniques for selecting all members of a container—then 
you can just copy or delete the shapes in the usual way.

To delete the container but leave its contents behind, you could drag the contents out 
and then delete the container. However, Visio provides a Disband Container command 
for this purpose.

TIP  You can lock a container to prevent shapes from being added or deleted. If you 
attempt to add a shape to a locked container, the border does not light up as you drag 

the shape onto the container and the new shape sits on top of the container. If you attempt to 
delete a contained shape, you receive an error message.

To place an empty container on the page

1.	 On the Insert tab, in the Diagram Parts group, click Container.

2.	 In the Container gallery, click the thumbnail of the container type you want.

To contain existing shapes

1.	 Select one or more existing shapes, and then do one of the following:

●● Display the Container gallery, and then click the thumbnail of the container 
type you want.

●● Right-click one of the selected shapes, and then click Add to New 
Container.

●● If the shapes are on top of, but are not members of, a container, right-click 
one of the selected shapes, and then click Add to Underlying Container.

To add shapes to a container

1.	 Drag one or more shapes into the container.

Or

1.	 Do either of the following:

●● Resize a container until it covers the shapes you want to add.

●● Drag a container until it’s on top of the shapes you want to add.

2.	 Right-click one of the shapes, and then click Add to Underlying Container.

Organize shapes by using containers
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To select a container

1.	 Do either of the following:

●● Click the heading section of the container.

●● Click any edge of the container.

To select all contained shapes

1.	 Do either of the following:

●● Select the container, and then on the Format tool tab, in the Membership 
group, click the Select Contents button.

●● Right-click any edge of the container, point to Container, and then click 
Select Contents.

To remove shapes from a container

1.	 Drag the shape you want to remove until it is outside the container.

To delete a container but leave contained shapes

1.	 Do either of the following:

●● Select the container, and then on the Format tool tab, in the Membership 
group, click the Disband Container button.

●● Right-click any edge of the container, point to Container, and then click 
Disband Container.

To lock or unlock a container

1.	 Do either of the following:

●● Select the container, and then on the Format tool tab, in the Membership 
group, click the Lock Container button.

●● Right-click any edge of the container, point to Container, and then click 
Lock Container.

Format containers
When you drag a container onto the page, it includes a set of predefined style 
attributes. You can change some of the most visible container attributes by using the 
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commands on the Format tool tab that is shown in Figure 13-7. You can alter other 
container characteristics by using buttons on the other Visio tabs.

Container attributes you can alter include the following:

■■ You can switch to another of the 14 container styles.

■■ You can choose alternate heading styles; Visio offers either two or four heading 
styles per container type. You can also hide the heading.

■■ You can select different themes, variants, and effects. Because containers 
respond to those changes, the appearance of the containers on your draw-
ing page (and their thumbnails in the gallery) can be very different from one 
diagram to the next.

■■ You can change the fill, line, and shadow attributes of a container as you would 
any other Visio shape.

To choose a different container style

1.	 Do any of the following:

●● On the Format tool tab, in the Container Styles group, display the Container 
Styles gallery.

●● On the Home tab, in the Editing group, click the Change Shape button.

●● Right-click the heading or edge of the container, and then on the mini tool-
bar, click the Change Shape button.

2.	 Click the container style you want.

To choose a different heading style

1.	 On the Format tool tab, in the Container Styles group, click the Heading Style 
button.

2.	 In the Heading Styles gallery, click the thumbnail of the heading style you want.

To hide the heading

1.	 Display the Heading Styles gallery, and then in the No Heading section, click 
the No Heading thumbnail.

Organize shapes by using containers
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On the border
When you drag a shape into a container, a green outline appears on the border 
of the container. This is true even when you drag a shape most of the way, but 
not fully into the container. In Figure 13-10, the wireless access point is being 
dragged into a container and will be added to the container when it is released, 
even though it is not fully within the borders of the container. (Depending on 
the resize options described just after this sidebar, the container might expand 
to encompass the new shape.)

Figure 13-10  The majority of the wireless access point is within the container

The pair of images in Figure 13-11 shows a different container behavior that can 
be useful in some diagrams. In the image on the left, the wireless access point 
has not been dragged quite as far into the container as it was in Figure 13-10. 
The container signals the difference by displaying a green outline only on the 
top border and not all the way around.

When you release the wireless access point in this situation, it becomes a 
member of the container, but it remains attached to the edge. If you expand 
the size of this container upwards, the border shape will move along with the 
top of the container, as shown in the image on the right.
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Another example of a shape on the border of a container is included in the 
“Build wireframes” section of the “Find containers and lists in Visio” topic later 
in this chapter.

Figure 13-11  A wireless access point is added to the border because it was dropped on the edge

Control container size
Visio containers expand automatically when you add shapes near the edge of the 
container. You can change this default behavior by using the Automatic Resize button 
located in the Size group on the Format tool tab. Clicking the Automatic Resize 
button, which is shown in Figure 13-7, reveals three mutually exclusive options:

■■ No Automatic Resize  The container does not expand when you drag shapes 
near the edge.

■■ Expand as Needed  The container expands when you drop shapes near the 
edge. Note that the opposite is not true—the container does not shrink when 
you remove shapes.

■■ Always Fit to Contents  The container expands and contracts automatically 
when you add or remove shapes.

Organize shapes by using containers
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You can also affect container size by using the other buttons in the Size group:

■■ Margins  Sets the spacing between the edges of the container and the contained 
shapes

■■ Fit to Contents  Sets the container size to the minimum required for the con-
tained shapes plus the margin

TIP  You can also resize a container to fit its contents by opening the container’s 
shortcut menu and then choosing from the options on the Container submenu.

Organize shapes by using lists
A list is a special type of container that maintains its members in ordered sequence. 
When you drag an object into a list, it takes a specific place before, between, or after 
existing members. Each list member knows its relative position in the list.

Visio doesn’t provide a list gallery on the Insert tab in the same way that it offers a 
Container gallery. Consequently, creating a list either requires reusing an existing list 
shape or having enough technical knowledge to make changes to the ShapeSheet.

SEE ALSO  For information about modifying the ShapeSheet and creating custom list 
shapes, see Appendix A, “Look behind the curtain.”

This topic explores adding shapes to a list and reordering shapes within a list. The list 
shape for this hypothetical scenario is called My New PC, to which will be added rect-
angular shapes that represent the software to load onto the PC. The starting point is 
shown in Figure 13-12, with the list in the center and the software shapes on either side.

Figure 13-12  A list shape surrounded by candidate members
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The software shapes for this example were created with two special attributes:

■■ Each shape displays the name of a software product that is stored as shape 
data. The shape data value is displayed by using a Visio field.

SEE ALSO  For more information about Visio fields, see Chapter 8, “Work with 
shape data.”

■■ Each shape displays its relative position in the list when it is in a list. When the 
shape is not in a list, it doesn’t display any number. Display of the list position 
for each shape was accomplished by using two ShapeSheet formulas.

The goal for the example in this topic is to create a list that shows the installation 
sequence for a new PC. Although you are unlikely to use a Visio list for this specific 
purpose, this example might stimulate you to think of your own applications for 
position-aware shapes.

Add shapes to lists
Dragging a shape into a list triggers the same response shown for a container earlier 
in this chapter: the list is surrounded by a green rectangle, as shown on the left in 
Figure 13-13. Also like a container, the list displays the green border when any member 
shape is selected, as shown on the right.

Figure 13-13  List borders illuminate when shapes are being added or are contained

In the real world, it isn’t possible to install Visio without installing Windows first, so 
Figure 13-14 shows the Windows 10 shape being dragged into the list. On the left, as 
the Windows rectangle first approaches the list, there are three visual responses:

■■ The list border turns green.

■■ A ScreenTip appears, displaying the words Insert Shape.

■■ A horizontal, orange insertion bar appears below the Visio 2016 shape.
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The insertion bar is Visio’s way of telling you that the new shape will be added to the 
list at that specific location.

The image in the center shows the Windows shape positioned partially above the 
Visio shape, with the result that the insertion bar is now located above the Visio 
rectangle.

The result of dragging the Windows rectangle above the Visio shape is shown on the 
right. Notice that the label Windows 10 is now preceded by the number 1 and the digit 
in front of Visio 2016 has changed from a 1 to a 2.

Figure 13-14  New shapes are added to a list in specific positions

You can insert new shapes between existing list shapes. In Figure 13-15, the Office 2016 
shape is being added before Visio 2016 and after Windows 10.

Figure 13-15  You can insert a shape between existing list shapes

�

TIP  Although the blue triangle that appears at the left end of the orange insertion bar 
in the image on the left in Figure 13-15 might appear when you drag a shape into a list, it 

is primarily useful when you are not dragging a shape.

�If you pause when pointing to the edge of a list between existing shapes, the Insert Shape 
triangle appears. Clicking the triangle causes Visio to insert a shape at that location in the list. 
If the shape designer specified a default list shape, then that shape is inserted. If there isn’t a 
default list shape, the shape adjacent to the insertion bar is added to the list. “Find containers 
and lists in Visio” later in this chapter includes an example of shape insertion.
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The preceding figures illustrate a key behavior difference between Visio lists and 
containers: container members can be located anywhere within a container, but list 
members are always in fixed positions.

Figure 13-16 illustrates another important difference: unlike shapes in a container, list 
members cannot reside on the border of the list. On the left, the Visio Add-In shape is 
positioned on the border of the list. Only a small percentage of the rectangle is actually 
touching the list, and yet releasing the shape at this point causes it to “fly” into the list.

Figure 13-16  Lists do not allow border shapes

Not only can shapes be inserted into specific positions in a list, they can be rearranged 
within the list. On the left in Figure 13-17, the Visio 2016 shape is being relocated so it will 
appear above the Visio add-in shape. Notice that each shape is renumbered automati-
cally based on its new list position.

Figure 13-17  List shapes can be dragged to new locations

The example in this section uses a vertical list in which shapes are automatically 
placed from top to bottom. A Visio list can be either vertical or horizontal and can 
sequence shapes in either direction within the list. These attributes are controlled by 
parameters and don’t require writing code, but you can’t change them from the Visio 
ribbon; you must make changes in the ShapeSheet for the list.

Organize shapes by using lists
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To add shapes to a list

1.	 Do either of the following:

●● Drag one or more shapes into the list.

●● Use the Insert Shape arrow to position a shape where you want it.

SEE ALSO  For procedures related to selecting a list, selecting all members of a list, 
locking or unlocking a list, deleting a list, or disbanding a list, see the procedures in the 

“Use containers” section of the “Organize shapes by using containers” topic earlier in this 
chapter.

Format and size lists
You can adjust most of the same format and size options for a list that you can for a 
container, with one notable exception: you cannot change the size of a Visio list shape. 
Visio controls the size by expanding and contracting a list so it is the exact size of its 
member shapes plus the margin around the shapes.

The Format tool tab described earlier in this chapter provides the following list-
related groups and the functions within them:

■■ Size group  You can use the Margins button to adjust the spacing between the 
edges of the list and the contained shapes. Because Visio controls the size of a 
list shape, Fit To Container and Automatic Resize are dimmed.

■■ Container Styles group  You cannot change the style of a Visio 2016 list. 
However, you can change the style of a list created in Visio 2010 by using the 
Container Styles gallery. This is true even if the Visio 2010 list is located in a Visio 
2016 diagram. You can use the Heading Style gallery to choose alternate heading 
placement and style options.

■■ Membership group  The Lock Container, Select Contents, and Disband Con-
tainer buttons provide the same functions for lists that they do for containers.

Find containers and lists in Visio
Several Visio 2016 templates take advantage of the properties of containers and lists 
to enhance ease of use and to add valuable features. In this section, you will discover 
three examples.
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Explore swimlanes
Cross-functional flowcharts, also known as swimlane diagrams, provide one of the 
most prominent examples of list and container usage in Visio.

SEE ALSO  For more information about swimlane diagrams, see Chapter 4, “Create 
business process diagrams.”

The swimlane add-in was completely redesigned when lists and containers were 
introduced in Visio 2010. The net effect of the redesign is that a cross-functional flow-
chart (CFF) is a list of containers: the framework that holds swimlanes is a list, and each 
swimlane is a container.

IMPORTANT  Swimlane diagrams created in Visio 2016, Visio 2013, or Visio 2010 will 
open directly in Visio 2016 because they share the same underlying container and list 

structure. However, swimlane diagrams created in earlier versions of Visio must be converted to 
the new swimlane structure, and, once converted, they can no longer be edited with the older 
software. To warn about the impending conversion when you open an older diagram, Visio 
displays a dialog box that gives you an opportunity to save the older version of the diagram 
before converting it.

Evidence of containers and lists appears as soon as you drag a shape into a swimlane—
a green border appears around the lane, as shown in Figure 13-18.

TIP  Notice that two Dynamic Grid feedback elements also appear inside the swimlane, 
informing you that the new shape is at the left margin of the lane and is centered 

vertically within the lane. For more information about the Dynamic Grid, see Chapter 2, “Create 
diagrams.”

Because the overall swimlane structure is a list, it includes a heading. Similarly, each 
swimlane has a heading. You can change the text of either, which was done in the 
image shown in Figure 13-18, by selecting the swimlane structure or a swimlane and 
then entering text.

Figure 13-18  The combination of container feedback and the Dynamic Grid simplify positioning of new 
shapes in a swimlane

Find containers and lists in Visio
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Further evidence that the swimlane structure is a list is shown in Figure 13-19. With 
the pointer at the left end of the lanes and positioned on the boundary between two 
lanes, the Insert Shape triangle appears.

TIP  If you compare the Insert Shape triangle in Figure 13-19 with the one shown in 
Figure 13-12, you’ll notice that the one in Figure 13-19 includes the name of a specific 

shape. The name appears because the swimlane list was preconfigured to insert a specific shape. 

Figure 13-19  Adding new lanes to a diagram is easy because of the list structure

Clicking the Insert Shape triangle produces the result shown in Figure 13-20. Notice 
that Visio extends dynamic connectors, as required, to accommodate the new lane.

Figure 13-20  Visio rearranges existing lanes when you add or remove lanes

Because swimlanes reside in a list, you can rearrange the sequence of swimlanes by 
dragging the heading of a lane up or down.

Swimlane diagrams derive another benefit from being built by using containers: shapes 
in a container know where they are contained. To find evidence of this, examine the 
Function field in the shape data for any flowchart shape in a swimlane.
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As an example, data for the process shape in the upper left of Figure 13-20 is shown in 
the image on the left in Figure 13-21, and the data for the decision diamond is shown 
on the right. In both cases, the value in the Function field is derived dynamically from 
the swimlane heading. If you change the value of the swimlane title, the Function field 
will be updated for all contained shapes. If you move a shape to a new lane, the Func-
tion field will reflect the heading of the new lane.

Figure 13-21  The Function field automatically displays the name of the swimlane that contains each 
flowchart shape

Build wireframes

IMPORTANT  The information in this topic applies only to the Professional edition of 
Visio 2016. 

Visio 2016 includes a revamped set of user interface (UI) design shapes that were 
initially introduced in Visio 2010. For this topic, the key point of interest about the 
redesigned shapes is that many of them are either containers or lists.

Software designers use wireframe shapes to create mockups of dialog boxes and 
other visual elements that will be displayed by their applications. When you use Visio 
2016 to create a mockup of a dialog box, you will find that the Dialog Form shape is 
a container. Consequently, as you add buttons and controls to your dialog box, those 
buttons and controls become container members. If you move, copy, or delete your 
dialog box, all of the contained shapes are automatically included. If you have ever 
created a UI mockup by using Visio 2007 or earlier, it won’t take more than a moment 
or two of experimentation to realize how significant an improvement this is.

Some Visio 2016 UI shapes are lists, including, not surprisingly, the List Box control. 
When you drag one into a Dialog Form container, the list is prepopulated with three 
list members. You can add, delete, and resequence list members by dragging them, as 
described in “Add shapes to lists” earlier in this chapter.

Find containers and lists in Visio
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TIP  As a shape designer, you can configure a list to automatically add one or more 
member shapes when the list is added to a page. Creating a shape with that feature is 

outside the scope of this book, but you can find information on this subject at msdn.microsoft.com 
/en-us/library/ff959245.aspx. 

The following three figures highlight some of the containers and lists in the wireframe 
template.

Adding a button control to a Dialog Form container lights up the border of the dialog 
box shape, as shown in Figure 13-22.

Figure 13-22  The Dialog Form shape is a container

On the left in Figure 13-23, a panel is added to the dialog box container. Because the 
panel shape is, itself, a container, adding a tab to the top edge of the panel causes the 
top panel border to illuminate.

Figure 13-23  Multiple containers comprise the wireframe shapes

SEE ALSO  For information about border shapes, see the “On the border” sidebar earlier 
in this chapter.

TIP  Because the panel shape is a container but doesn’t have a visible heading, you can 
select it only by clicking its edges.

The list box control exhibits standard list behavior when adding new list elements, as 
shown in Figure 13-24.
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Figure 13-24  A list inside a container inside a container

The wireframe shapes provide further evidence that nested containers and lists are 
practical solutions for creating Visio diagrams.

Insert data graphic legends

IMPORTANT  The information in this topic applies only to the Professional edition of 
Visio 2016.

In Chapter 9, “Visualize your data,” you worked with data graphics and then added an 
automatically generated legend to your diagram. A data graphic legend is actually a 
structure consisting of an outer list, one or more containers as list members, and lists 
within those containers.

For example, the same legend is shown in both images in Figure 13-25. The structure 
is loosely visible on the left. However, after selecting the entire legend, the telltale 
green borders are apparent on the right. You can identify three containers—Legend, 
Owner, and Risk—and two vertical lists, one in each of the Owner and Risk containers.

Figure 13-25  Data graphic legends are created from lists and containers

Find containers and lists in Visio
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When you work with data graphic legends, you will discover that you can add, delete, 
rename, edit, and move legend components, just as you can with the headings and 
members of any unlocked containers and lists.

Annotate shapes by using callouts
Many generations of Visio have included more than three dozen callouts that you can 
use to add comments to any shape on the drawing page. Those callouts still exist in 
Visio 2016. Figure 13-26 shows some examples.

Figure 13-26  Six classic callout examples

TIP  To locate the classic callouts, in the Shapes window, click More Shapes, click Visio 
Extras, and then click Callouts. 

However, using classic callouts is often a challenge because fundamentally they are 
just ordinary shapes. For example, all of the following are common annoyances of the 
classic callouts:

■■ Deleting the shape to which a callout is attached does not delete the callout, 
which can leave orphan callouts throughout your diagram.

■■ Moving the shape to which a callout is attached does not move the callout.

■■ Moving a callout disconnects the callout from the shape to which it’s attached 
unless you know exactly which control handle to drag.

Visio 2016 structured callouts behave more logically, primarily because, like containers 
and their members, there is an active association between a callout and the shape to 
which it’s attached.

Just as there is a Container gallery, there is also a Callout gallery, as shown in 
Figure 13-27.
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Figure 13-27  The Callout gallery features 14 callout styles

Figure 13-28 illustrates the following ways that structured callouts appear and behave 
more logically than groups:

■■ In the image on the left, selecting a callout highlights the shape to which it’s 
attached by using a familiar green border. Note that the opposite is not true: 
selecting the attached shape does not highlight the callout.

TIP  The callout in this image is connected to the shape by a visible tail, which 
might make the green highlight seem redundant. Not all callout styles have 

visible tails, however. Consequently, this feature is particularly valuable for those styles.

■■ In the center image, moving a callout by dragging it appears to disconnect it. 
However, when you release the connector it is still attached, as shown on the 
right.

Figure 13-28  Structured callouts are associated with the attached shape and remain attached even when 
you move them

Annotate shapes by using callouts
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Unlike containers and lists, callouts do not have a tool tab that you can use to switch 
styles. However, you can take advantage of the Change Shapes feature in Visio to 
replace any callout style with a different one. Figure 13-29 uses Live Preview and the 
mini toolbar to show how the callout from Figure 13-28 can be changed to the Word 
Balloon style.

Figure 13-29  Alternate callout styles are available via the Change Shapes feature

The following list summarizes the behavior of new style callouts:

■■ If you delete a callout, it doesn’t affect the shape to which it was attached. 
However, if you delete the shape, the callout is also deleted.

■■ If you copy a shape that has a callout attached, both the shape and the callout 
are copied.

■■ You can attach more than one callout to a shape.

■■ If you do not have any shapes selected when you insert a callout, Visio inserts 
the callout in the center of the drawing window.

■■ If you select more than one shape before inserting a callout, Visio attaches a 
callout to each selected shape.

■■ Callouts respond to themes and variants, so their appearance on the page 
remains consistent with the rest of your diagram.

SEE ALSO  For information about configuring callouts to read and display shape 
data from the shape to which they are attached, go to blog.bvisual.net/2014/04/08 

/adding-configure-callout-functionality-to-visio-callouts/. For more information about 
callouts, visit the Visio development team blog at blogs.office.com/b/visio/archive/2012 
/11/05/containers-and-callouts-in-visio.aspx.
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To attach a callout to a selected shape

1.	 On the Insert tab, in the Diagram Parts group, click the Callout button, and 
then click the callout style you want.

To change a callout to a different style

1.	 Do one of the following:

●● On the Home tab, in the Editing group, click the Change Shape button, and 
then click the callout style you want.

●● Right-click the callout, and on the mini toolbar, click the Change Shape 
button, and then click the callout style you want.

To relocate a callout

1.	 Click anywhere on the callout or its tail, and then do one of the following:

●● Drag the callout to a new location.

●● Move the callout by using the arrow keys.

Or

1.	 Relocate the shape to which the callout is attached.

To detach a callout

1.	 Select the callout, and then drag the yellow control from the center of the 
attached shape to anywhere outside the attached shape.

To delete a callout

1.	 Do one of the following:

●● Click the callout, and then delete it.

●● Click the shape to which the callout is attached, and then delete the 
attached shape.

Annotate shapes by using callouts
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Skills review
In this chapter, you learned how to:

■■ Understand containers, lists, and callouts

■■ Compare groups and containers

■■ Organize shapes by using containers

■■ Organize shapes by using lists

■■ Find containers and lists in Visio

■■ Annotate shapes by using callouts
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Practice tasks
The practice files for these tasks are located in the Visio2016SBS\Ch13 
folder. You can save the results of the tasks in the same folder.

Understand containers, lists, and callouts
There are no practice tasks for this topic.

Compare groups and containers
There are no practice tasks for this topic.

Organize shapes by using containers
Open the OrganizeByContainers diagram in Visio, and then perform the following tasks:

1.	 Place an empty container on the page, and then label the container Datacenter.

2.	 Place the Branch Office 1 shapes into a container, and then label the container 
Chicago.

3.	 Add several new shapes from the Servers stencil to the empty container.

4.	 Add several new shapes from the Servers stencil to the Chicago container.

5.	 Enlarge the Chicago container, select all shapes in the Datacenter container, 
and then move them to the Chicago container.

6.	 Drag two network shapes from the Chicago container to the Datacenter con-
tainer, and then lock the Chicago container.

7.	 Disband the Datacenter container.

8.	 Place all of the Branch Office 2 shapes into a new container.

9.	 Change the style of the Branch Office 2 container, and then move the heading 
to a new location.
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Organize shapes by using lists
Open the OrganizeByLists diagram in Visio, and then perform the following tasks:

1.	 Drag various software shapes into the My New PC list, being sure to add shapes 
at the top and bottom of the list and between existing list members.

2.	 Move a shape from the middle of the list to the top.

3.	 Make a copy of the My New PC list, and then lock the copied list.

4.	 Drag shapes from the Rack Mounted Servers stencil to the Store Shelf list. 
Notice that the list grows from left to right and not from top to bottom.

5.	 Move the Store Shelf list to another part of the page.

Find containers and lists in Visio
There are no practice tasks for this topic.

Annotate shapes by using callouts
Open the AnnotateShapes diagram in Visio, and then perform the following tasks:

1.	 Attach a callout to the park shape, and then assign a name to the park.

2.	 Attach a different style of callout to the airport shape.

3.	 Move the airport shape and observe the change in its callout.

4.	 Change the location of the callout attached to the park.

5.	 Detach the callout from the airport and attach it to the city instead.

6.	 Delete the city.

7.	 Delete the callout that is attached to the park.

446

Chapter 13



Index
Symbols
1-D shapes  65, 76, 525
2-D shapes  65, 245, 525
3-D equipment shapes  244
3-D rotation effects  222

A
absolute links  366–370, 525
Account page (Backstage view)  20–21
action tags  525
active pages  525
active windows  525
Activity (BPMN) shapes  525
Activity (General)  525
add-in tab  525
add-ins  24–25 , 150, 525
Add on drop data field attribute  280
Advanced Data Graphics button  308
Advanced Data Graphics gallery  334, 342
aligning

shapes, automatically  211–213
shapes, manually  206–209
text  523

anchor shapes  525
attaching comments  104
designating  208

angles of rotation  30
annotating shapes  440–443
annotations

adding to shapes  96–97
callouts  105
comments  104–105
ScreenTips  104–105

Arc tool  68
Area Select tool  52, 525
Auto Size  128–129, 525
AutoAdd  83–85, 525
AutoCAD  392
AutoConnect  525

activating  78
adding shapes  81, 82

connecting shapes  79
flowcharts  78, 144
linking shapes  82
live preview  80
turning off  82

autocorrect options  22
AutoDelete  86–87, 526
Automatically Open Web Page In Browser 

option  406

B
background pages  526

applying  132, 134–136
assigning to existing pages  133
automatic vs. manual  132
changing titles in title blocks  132
creating automatically  132
creating manually  134
deleting from diagrams  132
linking to foreground pages  121, 130
removing from foreground pages  132, 134
value of  121

backgrounds  378, 526
Backstage view  7, 13, 526

accessing  13
Account page  20–21
commands  13
Export page  20
Info page  14–16
New page  16
Open page  17
Print page  18
returning to diagrams from  13
Saving/Save As page  17–18
Share page  18–20
viewing metadata  380
Visio Options  22

Basic Electrical template  6
Basic Flowchart validation rule set  448
Basic Network Diagram stencils  240
Basic Network Diagram template  242

535



bevel effects  222–223
Blank Drawing template  9
Boolean shape data field  268, 278
borders

containers  428–429
inserting on background pages  130

bounding boxes  37, 51–52, 526
selecting shapes in containers  418, 422
selecting shapes in groups  422

BPMN (Business Process Model and 
Notation)  526

BPMN Diagram template  6
BPMN Diagram validation rule set  448, 456
BPMN diagrams

See also diagrams
Activity shapes  525
activity types  157
adding text annotations  163
annotating shapes  162
basic shapes  158
callout shapes  162
connector types  157
core shape sets  156
creating subprocesses  164–167
designing  158–163
event types  156
Gateway shapes  528
gateway types  157
setting activity types  163
setting gateway types  163
setting loop types  163
symbol set  156
uses for  155–156
validating  456

Business Process Model and Notation 
(BPMN)  526

business validation rule sets  448

C
callout shapes  162
callouts  308, 416

attaching to shapes  443
changing styles  443
deleting  443
detaching  443
gluing to shapes  162

locating  440
relocating  443
using  440–442

canvas  29
categories  10, 12
Change Shape  526
charts  See organization charts
Check Diagram  449, 526
Civil Engineering diagrams  258
coauthoring  483–484, 489
collaborating  105, 526
Color By Value graphics  308, 310–311, 313, 526
color palette  214
color picker  227, 229–230, 232
color schemes  213, 220
color selector  228
colors

applying solid fills  229
applying to lines  232
changing for icon sets  310
choosing  219
creating  228
customizing  219, 221
deleting custom sets  220
hue  529
Hue-Saturation-Lightness (HSL)  529
locking for shapes  227
saturation  529
specific values  228

comma-separated value (CSV)  526
comment indicators

balloons  105
hiding/showing  109

comments  526
added by different authors  106
adding  481–482
adding to diagrams  104
adding to pages  106, 108
adding to shapes  104, 108
attaching to anchor shapes  104
balloons  105
collapsing  106
deleting  482
deleting individual  106
displaying  105
drawing pages  477
editing  482

536

bevel effects



indicators  105, 109, 477, 482
interactive  464
order of display  104
replying to  108, 482
vs. ScreenTips  105
threaded  104, 106
viewing  482
viewing all  107
via web browsers  479

Comments pane  478
filtering comments  481–482
opening/closing  108, 471

Compatibility Mode  15, 513
Configuration button  342
Connecting Object shape  526
connecting shapes

using dynamic connectors  70–76
using lines  65–69

connection points  66, 526
See also lines
connecting shapes containing  70–72
Ethernet shapes  240
rack shapes  249
static glue  71–72

connector segments, adjusting  75
Connector tool  72, 527
connectors  526

See also dynamic connectors
changing styles  221
types  157
unglued  450

containers  416–419, 527
adding shapes  420, 425
borders  428–429
bounding boxes  418
choosing styles  427
creating  509–511
deleting  425
dragging shapes out of  422
dropping shapes into  422
entering text  422
formatting  426–427
vs. groups  417–422
hiding headings  427
locking/unlocking  425–426
organizing shapes  423–424
placing on pages  425

removing shapes  426
resizing contents  422
selecting  418, 424
selecting shapes  418, 422, 424, 426
sizing  429
styles  424
and swimlanes  435
using  424–426

control handles  527, 531
hiding  241
locked  61
moving interior vertical lines  61
reshaping lines  68
rotation handles  61
shape size, adjusting  62
yellow handles  62

copying shapes  53–54
cropping photos  201
cross-functional flowchart diagrams 

  See swimlane diagrams
Cross-Functional Flowchart validation rule set  448
CSV (comma-separated value)  526
Currency shape data field  268, 278
Custom Import  326, 527

linking diagrams to data  333
using  330

custom properties  527
custom templates, storing  395–396

D
Data Bar graphics  308, 312, 317
data fields  268, 308–309

attributes  279–280
changing attributes  281–283
changing properties  281
creating new  281–283
labeling  283
predefined  270
rules  276

Data Graphic Fields task pane  343
data graphic legends  306, 319–320, 527
data graphics  527

See also shapes
applying  343
applying during data linking  334
applying multiple to process steps  314

537

data graphics



data graphics (continued)
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drawing windows  28–29, 528
arranging  519
moving around in  516
page controls  29
page name tab  530
pan and zoom  37
status bar  29–31
zooming in/out  37

drawings  527
AutoCAD  392
changing to unscaled  258
language  30
page numbers  30
previewing  376–379
running reports stored in  290
saving in other file formats  390–394

Duplicate Page  528
duplicating shapes  55
Duration shape data field  268, 278
.dwg file extension  392
.dxf file extension  392
dynamic connectors  65, 70, 528

See also connectors; diagrams; shapes
applying styles  220
AutoAdd  525
AutoConnect  77–83, 525
AutoDelete  526
changing styles  74–76
connecting shapes  148
connection points  71
dynamic glue  74
gluing to connection points  72, 79
gluing to shapes  74
line bends, creating  76
moving segments  76
moving shapes  75
removing text block backgrounds  161
resetting  75–76
segmentation, changing  74–76
static glue  72, 74

dynamic glue  74, 77, 528, 146–147
Dynamic Grid  528

activating  49
aligning shapes  46, 49
drawing tools  48
guidelines  46, 153
spacing shapes  46, 49
vertical spacing of shapes  48

dynamic links  326

E
effects  213, 528

3-D rotations  222
applying  222–224
bevels  222–223
changing  224
controlling properties  223
customizing  221
glows  222
reflections  222
removing  224
selecting  220
shadows  222
soft edges  222
types  222

email addresses, hyperlinks to  360
embellishments  528
endpoints  See connection points
enterprise networks, diagramming  244
errata, submitting  xix
Ethernet networks, diagramming  242
Ethernet shapes

adding devices to  242
network diagrams  240–241

event types  163
Events shapes  528
Excel

displaying report output in  287
linking to cells  363

Export page (Backstage view)  20
Extensible Application Markup Language 

(XAML)  404, 534
Extensible Markup Language (XML)  534
External Data window  326

F
Featured templates  9, 12
feedback, submitting  xix
fields

in data graphics  312
inserting  511–512

file extensions  391–392
file formats

graphics  386–388
macros  391
previous Visio versions  391
XML-based Open Packaging Convention  513
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file types  392
files

opening from previous versions  513
opening in compatibility mode  15
saving to SharePoint  466–467

fill colors  229
fill patterns  228
fills, removing  230
fit to window  515
Fixed List shape data field  268, 278
fixed lists  276–277, 528
flipping shapes  519
flowcharts  528

See also diagrams
adding shapes  148
adding text to shapes  148
building quickly  145
connecting shapes  78, 148
creating  142–145
cross-functional  527
default font size  142
exiting text entry mode  149
guidelines  145
ignoring validation issues and rules  453
live preview  144
orientation  142
templates  140–141
validating  449–454

footers, printing  378–379
foreground pages  528

adding after existing  123
autosizing  127
choosing paper size  126
configuring  125–128
definition  121
including/excluding gridlines  126
linking to background pages  121
managing properties  122
orientation  127
page name tabs  122
previewing  126
removing background pages  132, 134
scaling for printing  126
setting zoom level  126

Format data field attribute  279
Format Painter  233
formatting

text  523
text boxes  102

formulas, overwriting  504
Freeform tool  68
full-screen view, moving around in  517
functional bands  528

G
Gateway shapes  528
.gif (Graphics Interchange Format)  528
GIF webpage format  408
glow effects  222
glue  528
glued lines  67
gluing shapes on layers  118
Go to Page navigation pane  399, 405
gradient fills  228

applying to lines  233
applying to shapes  229

grammar options  22
graphic items  308, 528

creating  309
editing  316

graphics, file formats  386–388
Graphics Interchange Format (.gif)  528
gravity  528
grid  528
gridlines on foreground pages  126
grouping shapes  417, 519

changing properties  115
reasons for  114
selections  116

groups  528
adding shapes  420
vs. containers  417–422
dragging shapes out of  422
dropping shapes into  422
entering text  422
vs. layers  118
resizing contents  422
selecting interior shapes  422
selecting shapes using bounding boxes  422
selecting shapes within  116, 418

guides  529
aligning shapes  57–61
deleting  59
displaying  57
gluing shapes to  58
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guides (continued)
hiding  57
moving glued shapes  59
sizing shapes  57–61
vertical  58

H
Hand Drawn theme  214–215
handles  See control handles
headers, printing  378–379
Help window  524
Hidden data field attribute  280
hidden data, removing  381–383
Hide U Size command  250
hiding comment indicators  121
horizontal axis  209
HSL (Hue-Saturation-Lightness )  529
.htm/.html file extension  392, 529
HTML (Hypertext Markup Language)  288, 529
hue  529
Hue-Saturation-Lightness (HSL)  529
hyperlink base  370–372, 529
hyperlinks  401

See also linking
absolute  366–370
adding  365
adding to multiple shapes at once  356
deleting  364
displaying descriptions  365
editing  364
email addresses  360
following  354
opening Hyperlinks dialog box  355
relative  366–370
relative paths  362
specifying target  355
symbol on shapes  354
to Visio pages  356

Hypertext Markup Language (HTML)  288, 529

I
Icon Set graphics  308
icon sets  310–311
ignoring validation rules  453
images

creating from shapes  386–390
creating shapes using  109

file formats  386–389
inserting  110
using as backgrounds  130

Info page (Backstage view)  14–16 , 380–383
Information Rights Management (IRM)  6, 

384–385, 529
insertion bar  529
IRM (Information Rights Management)  6, 

384–385, 529
Issues window  450, 454

J
JavaScript  529
JPG/JPEG  529
JPG webpage format  408

K
keyboard shortcuts  515–524
KeyTips  517

L
Label data field attribute  279
labels, adding to shapes  103
lanes  See swimlanes
languages

drawings  30
parameters  22

LAN (local area network )  529
Lasso Select tool  51, 529
layers  529

adding new shapes  118
assigning shapes to  120
benefits of using  117
changing properties  120
controlling visibility of shapes  118
creating on pages  118–119
gluing shapes  118
locking shapes  118
managing object colors  118
predefined  117
printing  118
properties  116, 118
removing from pages  119
removing shapes  120
selecting all shapes  120
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snapping shapes  118
vs. groups  118

legends, data graphics  306, 319–320, 439, 527
Line tool  68, 529
lines

See also connection points; shapes
applying gradients  233
applying solid colors  232
arcs  68
changing arrow types  232
changing patterns  232
changing weights  232
color picker  230, 232
connecting shapes  65–70
connection points  66, 71
create 2-D shapes using  69
creating  65
customizing  231
drawing tools  68
formatting  71
freeform  68
glued/unglued  67
gluing to shapes  69, 71
static glue  71, 74
tailoring properties  231

linked data
See also data linking
changing column settings  339
data graphic options  341
identifying links  339
managing  339–340
refreshing  344–345
using data graphic options  341–344

linking
See also hyperlinks
adjacent shapes  82
background pages to foreground pages  130
to documents  361–362
to Excel cells  363
foreground pages to background pages  121
non-adjacent shapes  82
to OneDrive  21
to pages in different diagrams  357
to pages within diagrams  357
to PowerPoint slides  363
shapes using AutoConnect  77–83
to SharePoint sites  21

to specific locations in Office 
documents  362–364

to specific shapes  356, 359
to Visio pages  356
to websites  360
to Word bookmarks  363

list fields  276–277
lists  416, 430, 529

adding shapes  431–434
creating  509–511
formatting  434
and swimlanes  435

Live Preview  529
local area network (LAN)  529
LoopType data field  277

M
macro recorder  30
macros  391–392, 529

recording  506
running  506
security settings  507
vs. VBA  509

Marker theme  215
masters  8, 529–531
Maximum Value field  317
measurement units  11
Mechanical Engineering diagrams  258
metadata  380–384
metric  530
Metric diagrams  258
metric templates  11
Microsoft Press contact information  xix
Microsoft Press Store  xviii
Microsoft SharePoint 2010 Workflow validation 

rule set  448
Microsoft SharePoint 2016 Workflow validation 

rule set  448
Microsoft Silverlight  399, 404
Microsoft Visual Basic for Applications 

(VBA)  508–509
Minimum Value field  317
mini toolbar  530
Modern theme  214
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N
Name data field attribute  280
network diagrams

See also diagrams
2-D shapes  245
adding network cabling  259
adding rack diagram pages  252
building basic  240–242
building detailed  242–244
choosing shape styles  245
data linking  259
enhancing  259
Ethernet networks  242
Ethernet shapes  240–241
finding shapes  246
predefined reports  260
real-time  259
stencils  242

network performance  302–304
networks  244
New page (Backstage view)  16
null entries  282
Number shape data field  268, 278

O
Object Linking and Embedding Database  

(OLE DB)  530
objects

managing on layers  118
masters  8
shapes  8

ODBC (Open Database Connectivity)  530
OLE DB (Object Linking and Embedding 

Database)  530
one-dimensional shapes

identifying  76
lines  65

OneDrive, linking to  21
Open Database Connectivity (ODBC)  530
Open page (Backstage view)  17
Organization Chart Wizard

creating data charts  185–186
including photos  201
using with existing data  178–184

organization charts  530
add-in tabs  172
adding multiple shapes  176

adding names  174
adding photographs  196
adding titles  174
applying styles  188
applying themes  197
arranging shapes  189
building from existing data  177–184
building manually  173–177
building with Organization Chart 

Wizard  178–184
centering on pages  189
changing layouts  187–189
changing shape appearance  191–195
changing shape positions  176–177
changing style  194
correcting shape positions  189
correcting shape spacing  189
creating data charts  186
cropping photos  201
data source types  177
default style  193
deleting photos  197
editing photos  201
enhancing with data graphics  305–306
hiding sections  189
hyperlinking employee shapes  183
importing photos  198–200
layouts  187
moving shapes  189–190
replacing photos in shapes  196
restoring shape spacing  188
showing/hiding photos  197
showing/hiding subordinates  190
specifying page contents  182
synchronizing employee shapes  183
undoing changes  194–195
using templates  173
vertical spacing  189–190

Organize Supporting Files In A Folder 
option  406

orientation
changing for pages  128
flowcharts  142
of shape text  99
swimlanes  150, 151

544

Name data field attribute



P
page breaks, moving shapes off  211
page controls  530
page name tabs  122, 124, 530
pages

adding comments  106, 108
assigning background pages  133
backgrounds  121
changing orientation  128
copying attributes  122
creating from selections  164
creating layers  118–119
creating new  164
deleting  125
duplicating  124
duplicating contents  122
foregrounds  121
linking to shapes  164
moving  124
on-screen drawing settings  121
opening ShapeSheet  502
physical page settings  121
previewing  376
removing layers  119
renaming  123
resequencing  124
scrolling  32
viewing on web  398

Pan and Zoom navigation pane  400
Pan & Zoom window  37–39
panning  516, 530

diagrams  37–39, 41 , 470
print preview images  376
webpages  400, 403

pasting shapes  53–55
pattern fills  230
PDF (Adobe Portable Document 

Format)  392–393
Pencil tool  68
personal information, removing  381, 383
photos

adding to organization charts  196
cropping  201
deleting from shapes  197
deleting placeholders  197
editing  200–201

importing into organization charts  198
showing/hiding placeholders  197

pictures, creating shapes using  109
Pin Pos  See pin position
pin position  61, 63, 530
.png (Portable Network Graphic)  530
PNG webpage format  408
Pointer Tool  530
Portable Network Graphic (.png)  530
Position button  342
positioning shapes  207, 209–211
practice files  xvi–xviii
predefined reports, running  286–290
presentation mode  30
previewing

data graphics  313
diagrams  376–379
drawings  376–379
printer paper dimensions  377

Print page (Backstage view)  18
print preview  376–379
print tile  530
printers, choosing paper size  126
printing  376–378

backgrounds  378
changing page orientation  128
configuring page settings  127
diagrams  210, 379
footers  378–379
headers  378–379
image quality settings  378
layers  118
Move Off Page Breaks  377
moving shapes off page breaks  379
page ranges  378
scaling foreground pages  126

process map  530
Professional theme  214
Prompt data field attribute  280
properties

changing for layers  120
foreground pages  122
layers  118

publishing diagrams  398–403
different formats  404
setting options  404–409
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Q
Quick Access Toolbar  23, 496–497, 530
Quick Import  326–330, 530
Quick Import wizard  6
Quick Shapes  77, 530

adding shapes  83
changing order of masters  81
live preview  81
masters  83

Quick Start guide  12
Quick Styles  213, 225–226, 530

R
rack diagrams  247

adding to network diagrams  252
changing drawing scale  255–256
creating  251
enhancing with data graphics  302–306
publishing  259
scaled drawings  252
shape heights  250
stencils  247–248

Rack Mounted Servers stencils  242
rack shapes

adding data to  259
adjusting  250, 252
connection points  249
displaying heights  249
gluing on racks  249
and scaled drawings  249
showing/hiding U heights  251

rack units  249, 531
racks

adding hyperlinks  259
gluing shapes  249
U heights  251

Red-Green-Blue (RGB)  531
reflection effects  222
relative links  366–370, 531
relative path  362
Remove Hidden Information  380–383
Report Definition Wizard  291
reports  531

creating  291–296
displaying in Excel  287

displaying in shapes  288
displaying in web browsers  288
displaying in XML  289
modifying  291–295
modifying definitions  296
network diagrams  260
output choices  287
predefined  286
running  290
saving definitions  295
updating  289–290

resize handles  See control handles
resizing

Ethernet segments  242
Ethernet shapes  241
Server shapes  250
shapes  56, 242, 252

restricting access  384–385
reviewer’s marks, removing  381
RGB (Red-Green-Blue)  531
ribbon  531

add-in tabs  24–25
customizing  23, 493–496
KeyTips  517
navigating  517–518
tabs  532
tool tab groups  533
tool tabs  23–24

rotating
shapes  100, 102
text independent of shape  102
text in shapes  100–101

rotation angles
displaying  30

rotation handles  61–62, 531
rule sets  See validation rules
rulers  531

aligning shapes  56
displaying/hiding  56
positioning shapes  56, 57
sizing shapes  56

rules  531
templates  448
validation  448–449
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S
saturation  529
saving

diagrams as PDFs  393
options  22
Save/Save As pages (Backstage view)  17–18
to SharePoint  466–469

Scalable Vector Graphics (SVG)  532
scaled drawings  531

adjusting scaling factors  255, 257
creating custom ratios  253
definition  252
predefined scales  256
rack shapes  249
scale types  253

ScreenTips  104, 280, 365, 531
adding to diagrams  104
vs. comments  105

scroll bars in Shapes window  34
scrolling pages  32
Search Pages navigation pane  401
searching

full-text  401, 465
for templates  9, 13
webpages  401

security, macros  507
selection handles  See control handles
selection rectangles  531
selection tools  520, 525
Server shapes  250
Servers stencil  242
shadow effects  222
Shape & Position window  63
shape data  532

See also shapes
data fields  268, 275
editing  275–278
entering data values  268
entering in text fields  278
exiting fields  278
formatting  275
list fields  276–277
viewing  269–274, 471

shape data fields  268
allowing blanks  282
changing attributes  281, 283

changing default value  281–282
creating drop-down lists  282
defining  283
labeling  283
specifying internal name  283
specifying sort key value  283
types  268
viewing attributes  279–281
working with multiple shapes  280

Shape Data window  532
changing data values in  275–278
closing  273
docking  269, 273
hiding  269
locating  274
opening  273
positioning  273
resizing  269
setting default value  281

shape names  532
shapes  8–9

See also data graphics; diagrams; drawing 
tools; dynamic connectors; lines; shape data

2-D, creating with lines  69
2-D network  245
3-D equipment  244
action tags  525
Activity (BPMN)  525
activity types  157
adding comments  108
adding data fields  283
adding from stencils  82
adding hyperlinks  356, 365
adding labels  103
adding photos  196
adding ScreenTips  107
adding text  96–97, 148
adding to containers  425
adding to flowcharts  148
adding to layers  118
adding to lists  431–434
adding to organization charts  176–177
adding to swimlane diagrams  153
adding with AutoAdd  84–86
adding with Quick Shapes  83
adjacent, linking  82
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shapes (continued)
adjusting heights  252
adjusting sizes  163
adjusting spacing  209
adjusting with control handles  62
aligning  49–50, 206–209, 211, 213
aligning on axes  49
aligning using Dynamic Grid  241
aligning using guides  57–61
aligning using rulers  56
anchors  208, 525
annotating  96, 162, 163
annotating using callouts  440–443
applying data graphics  306, 313, 315, 342
applying effects  222–225
applying gradient fills  229
applying pattern fills  230
applying Quick Styles  226
applying solid fills  229
applying themes  214
area selection  51–52
assigning to layers  120
attaching callouts  443
attributes  62–65
AutoAdd  83–85
AutoDelete  86
automatically applying data graphics  315
basic  158
behavior  501, 504
bounding boxes  51–52
bringing to front  207
callouts  162, 440–443
canvas  29
changing data graphics  342
changing effects  224
changing height/width  195
changing vertical spacing  190
circles  50
coauthoring  483
collapsing comments  106
commenting  477
Connecting Object  526
connecting using dynamic connectors  70–76
connecting using lines  65–70
connecting without connection points  72–74
connection points  66
connector types  157

control handles  60–65
controlling visibility on layers  118
coordinates  62–64
copying  53–54
copying formatting  233
creating custom  497–499
creating from data  338–339
creating images from  386–390
creating multiple  339
creating new pages from  164
creating text-only  102
creating using drawing tools  48, 50
creating using images  109
data fields  309
deleting  86
deleting photos  197
determining names  358–359
disallowing themes  219
displaying dimensions  30
displaying report output  288
displaying rotation angles  30
displaying text in multiple places  114
distributing  209–210
dragging data to existing  334–335
dragging onto racks  249
duplicating  54–55
Dynamic Grid  46–51
editing text  518
embellishing  220–221
Ethernet  240–242
Events  528
event triggers  163
event types  156, 163
exiting text entry mode  97
finding  246
flipping  211, 519
formulas  504
gateway types  157, 163
glue  528
glued to guides, moving  59
gluing callouts  162
gluing lines  69
gluing on layers  118
gluing to guides  58
grid lines  48
grouping  114, 116, 519
guidelines  47
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guides  57–59
horizontal axis  209
horizontal position  207
hyperlink symbol  354
hyperlinks  401
inserting data values  284–285
inserting document properties  285
inserting fields  284, 511–512
interior vertical lines, moving  61
lasso selection  51–52
lines  65–70
linking data one page at a time  337–338
linking to data  333–339
linking to data automatically  335–337
linking to external data  327
linking to multiple data sources  333
linking to pages  164
linking using AutoConnect  77–84
listing links  365
live preview  223
locked  60
locked text  96
locking  118
locking colors  227
loop types  163
Microsoft-specific  246
moving  189–190, 516, 519
moving off page breaks  211
moving text blocks  99
Multiple Shapes  174
names  358, 532
non-adjacent, linking  82
one-dimensional  62
opening ShapeSheet  502
organizing using containers  423–424
orienting text  99
pasting  53–55
pin position  63
placing on pages  49
positioning  48, 55–59, 207, 209–211
positions on axes  207
properties  65, 501
protection  501
Quick Shapes  81–83
Quick Styles  225
rack  249
removing data graphics  313, 315–316

removing effects  224
removing fills  230
removing from containers  426
removing from layers  120
removing from selection  53
removing themes  219
replacing  111–113
replacing photos  196
repositioning  163
repositioning text  98–99
resizing  50, 56, 60, 163, 242
resizing text  98–99
resizing text blocks  99–100
restoring spacing  188
retaining alignment  54
rotating  61–63, 100, 102, 211, 519
rulers, using  56–57
running reports stored in  290
saving as masters  315
saving in custom stencils  315
selecting  51–53, 516, 525
selecting all on layers  120
selecting all that use data graphics  318
selecting from stencils  112
selecting multiple  52
selecting within groups  116
selection types  52–53
sending backwards  207
sheets  358
showing/hiding U heights  251
Size & Position window  62–65
size using guides  57–61
sizing  46–47, 50
smart shapes  532
snapping on layers  118
spacing  46–50, 209–211, 213
squares  50
subshapes, protecting alignment  114
text  532
text position  96
Three Positions  174
two-dimensional  62
ungrouping  115–116
unlinking from data  340
using different data graphics  314
values  63
vertical axis  209
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shapes (continued)
vertical positions  207
wireframes  437–439
X-axis  207
Y-axis  207
Z-axis  207

Shapes window  28, 532
adjusting width  34, 36
docking  36
expanding/minimizing  33, 36
floating  34
opening/closing  34, 36
opening stencils  36
scroll bars  34
status bar  29–31
switching to open stencils  33
undocking/floating  34, 36

ShapeSheet  430, 433, 502–505, 532
Share page (Backstage view)  18–20
SharePoint

incorporating diagrams  464
linking to  21
refreshing diagrams  471–476
refresh intervals  474
saving diagrams to  468–469
saving files to  466–467
viewing diagrams  470
Visio Services  464–465

sharing diagrams  18–20 , 464
sheets  358, 532
Show U Size command  250
Six Sigma Diagram validation rule set  448
Size & Position window  62–65
smart shapes  532
Snap & Glue  518
soft edges effects  222
Sort key data field attribute  280
spacing shapes  46–50

automatically  213
manually  209–211

spelling options  22
starter diagrams  25–28
static glue  71, 74, 77, 532

vs. dynamic glue  146–147
status bar  29–31, 532
Status shape data field  276

stencils  8, 521, 532
add shapes using AutoConnect  82
Basic Network Diagram  240, 242
creating custom  497–499
Detailed Network Diagram  242
diagrams  45
finding  247
network diagrams  242
Quick Shapes  81
Rack Mounted Servers  242
saving shapes in  315
selecting shapes from  112–113
Servers  242
shapes  45, 48
templates  45
titles, revealing  242

String shape data field  268, 278
subnet  532
subprocesses  164–166, 532
subshapes  114–115
SVG (Scalable Vector Graphics)  532
SVG webpage format  408
swimlane diagrams  532

See also diagrams
adding flowchart shapes  153
adding lanes  152, 154–155
add-ins  150
building  152–154
functional bands  149
improving process steps with data 

graphics  304
labeling  155
lane orientation  150–151
numbering process steps  304
uses for  149
validating  454–455

swimlanes  532
adding to diagrams  154
and containers  435
labeling  155
and lists  435
rearranging sequence  436
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T
tabs  532
task panes  532
TaskMap add-in  25, 306–307
tasks  532
Tell Me  5
templates  8, 532

Basic Electrical  6
Basic Network Diagram  242
Blank Drawing  9
BPMN Diagram  6
business rule sets  448
categories  10, 12
creating  394
custom  395–396
Detailed Network Diagram  240, 242
displaying information about  10
featured  12
flowcharts  140–141
frequently used  9
measurement units  11
metric  11
predefined layers  117
saving diagrams as  394
searching for  9, 13
starter diagrams  27
stencils  8
Unified Modeling Language (UML)  6
using existing diagrams  13
US Units  11
viewing from Start screen  7
wireframes  438–439

text
adding to containers  422
adding to groups  422
adding to shapes  96–97, 148
aligning  523
aligning in shapes  98
aligning in text blocks  99
annotations  163
controlling angle with formulas  101
editing  522
formatting  523
locking on shapes  96
orientation in shapes  99–101
position on shapes  96

preset positions  98
removing backgrounds  161
repositioning on shapes  98
resizing on shapes  98
rotating independent of shape  101–102
rotating on shapes  101
rotating with shapes  100

Text Block tool  98–99
text blocks  98–99, 532
text boxes  102–103
text fields, entering data  278
Text graphics  312
Text tool  102, 533
Theme gallery  214
themes  533

applying  214, 216–218
categories  214
choosing colors  219
color palettes  214
customizing  219–221
diagrams  213
disallowing for future shapes  219
effects  213
Hand Drawn  214
Marker  215
Modern  214
organization charts  197
Professional  214
Quick Styles  213
removing  225
removing from current page  218
removing from selected shapes  219
selecting alternate color schemes  220
selecting effects  220
Trendy  214
variants  213, 217, 533

Thermometer graphics  317
threaded comments  104, 106
tint slider  228
tips pane, removing  28
title blocks in background pages  132
toolbars  520
tool tab group  533
tool tabs  23–24
transparency  228
Trendy theme  214
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Trust Center  23
Twitter address for Microsoft Press  xix
two-dimensional shapes  65, 245
Type date field attribute  279

U
U heights  251
unglued lines  67
ungrouping shapes  116
Unified Modeling Language (UML) templates  6
Uniform Resource Locator (URL)  533
unique identifiers  331–332
unscaling drawings  258
upgrading from previous Visio versions  15
URL (Uniform Resource Locator)  533
user-defined cells  533
US Units templates  11

V
validating

BPMN diagrams  456
flowcharts  449–454
swimlane diagrams  454–455

validation  533
validation issues

highlighting shapes  453
ignoring  453–454
Issues window  450–451, 454
showing/hiding  454–455
sorting  450

validation rules  448–449
adding  457
creating new  458–460
editing  459
ignoring  452–454
importing into diagrams  457
Issues window  450–451
listing  458
selecting  450

Value data field attribute  280
Variable List shape data field  268, 278
variable lists  276, 533
variants  533

applying  218
changing connector styles  221

changing embellishment levels  221
customizing  219–221

VBA (Visual Basic for Applications)  508–509, 533
VBE (Visual Basic Editor)  508, 533
.vdw extension  533
Vector Markup Language (VML)  533
vertical axis  209
views

fit to window  515
full-screen  517

Visio 2003-2010 Drawing  391
Visio 2003-2010 Stencil  391
Visio 2003-2010 Template  391
Visio 2016

add-ins  23
editions of  4
file formats  512–514
file types  391
new features  4–6
product ID  21
programming with VBA  508–509
Quick Start guide  12
scrolling pages  32
Start screen  7
switching windows  31
toolbars  520
user interface (UI) design shapes  437
version information  21

Visio Drawing  391
Visio Macro-Enabled Drawing  391
Visio Macro-Enabled Stencil  391
Visio Macro-Enabled Template  391
Visio engine  533
Visio Options (Backstage view)  22
Visio Professional 2016  4, 439

Quick Import wizard  6
starter diagrams  27

Visio Pro for Office 365  4
Visio Services  464–465, 533

collaborating on diagrams  476–477
data-linked diagrams  465

Visio Stencil  391
Visio Template  391
Visio Viewer  397
Visio Web Access  464, 470–471
Visio web drawing  533
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Visio Workflow Interchange  533
Visual Basic Editor (VBE)  508, 533
Visual Basic for Applications (VBA)  533
VML (Vector Markup Language)  533
VML webpage format  408
.vsd file extension  391
.vsdm file extension  391
.vsdx extension  534
.vsdx file extension  391
.vss file extension  391
.vssm file extension  391
.vssx file extension  391
.vst file extension  391
.vstm file extension  391
.vstx file extension  391

W
web browsers

Comments pane  481–482
filtering comments  482
reading/writing comments  477, 479, 482
updating diagrams  482
viewing diagrams in  469–471

Web Page format  392
Web Parts  475–476
webpages, moving around in  517
web-published diagrams

allowing/disallowing specific sources  468
navigating  398–403
setting options  404–409

websites, linking to  360
websites, Visio-generated

advanced settings  408–410
automatically opening in browsers  406
changing titles  404–405, 409
contents  410
copying  410
creating from diagrams  402
customizing  404–409
folder location  410
general settings  404–407
home pages  410
moving  410
navigation panes  399, 405
output formats  408
pan position  400

panning  403
publishing diagrams  398
publishing in different formats  404
searching for text  403
setting publishing options  404
specifying included content  405
storing pages  406
viewing different pages  403
viewing shape data  403
viewing specific pages  399
viewing using Internet Explorer  399–401
zoom level  400

windows
drawing  528
Drawing Explorer  527
Help  524
Shape Data  532
Shapes  532
switching  31

wireframe shapes  437–439
Word, linking to bookmarks  363
workflow  534
workspace  9, 534

X
XAML (Extensible Application Markup 

Language)  404, 534
X-axis  207
X-coordinate  534
XML-based Open Packaging Convention file 

format  513
XML, displaying report output  289
XML (Extensible Markup Language)  534
XML Paper Specification  392
.xps file extension  392
XPS Document  392

Y
Y-axis  207
Y-coordinate  534
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Z
Z-axis  207
zoom  534
zoom level

displaying current percentage  31
setting for foreground pages  126
webpages  400

zoom settings, changing  403
zoom slider  376
zooming  515

diagrams  37–40, 376
diagrams in web browsers  470
Internet Explorer  397

zoom slider  30
Z-order  207, 534
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